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Aims and Learning Objectives 

This course provides an introduction to Access 2013 databases. By the end of this course, 
you will be able to: 

 navigate within and between data entry forms; 

 edit, add, delete, sort, find and filter data; 

 create simple single, multi-table and action queries; 

 create a simple grouped report based on a multi-table query. 

Note: this document cannot be used with Access 2003; those using Access 2007 or 
Access 2010 will find minor differences. 
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Introduction 

In Access 2013 data is stored in tables. Each table holds data about a specific ‘thing’ and is 
related to at least one other table. Although the data is held in tables, the best way to access 
and edit data is not within these tables, but by using data entry forms. Queries are used to 
filter the data and also to do other things, some of which we will see on this course. Reports 
let you group the data together in printer-friendly format.  

 

Prerequisites 

You should be familiar with MS Office 2007, 2010 or 2013. 

Data security 

If you store or process restricted UoB data or sensitive personal information on a database, 
you should be aware of UoB regulations and legal requirements for protecting that data. 
Further information can be found on the University Secretary’s website at 
http://www.bristol.ac.uk/secretary/ and on the Information Security website at 
http://www.bris.ac.uk/infosec/. 
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Task 1 Opening the course database 

Objectives To open the course database and select the correct security setting. 

Comments If you forget to choose the correct security setting, just close the database and 
reopen it, this time choosing the correct setting.  

 

On opening Access, the Getting Started with Microsoft Office Access window is 
displayed. From here you can create a new database, access pre-created templates 
(not recommended) or, as we want to do, open a pre-existing database file. 

1.1 To open the Intro database: 

 Click on Open…, then navigate to where the training files are stored. If you are in 
the Training Room, you will be told where this is. If you are doing this course in your 
own time, see the notes on the back of the front page of this document for 
information on downloading the practice file. 

 Double-click on Intro.accdb to open the database. 

1.2 To select the correct response to the Security Warning: 

 

Figure 1 – select Enable Content 

 On the Security Warning message box, select Enable Content. 

 (If a further Security Warning opens asking if you want to make the file a “Trusted 
Document”, select No.) 

 Note that the database opens directly onto the data entry form – it does this 
because the Autoexec Macro tells it to do this when the file is opened. 

 
Figure 2 – the work environment showing the Ribbon (top) and Navigation Pane (left) 
with the Autoexec Macro circled 



Access 2013: An introduction (acc-45)  

 

2 

Task 2 Using the data entry form  

Objectives To find, enter, edit and delete data using a data entry form. To use the form’s 
Datasheet View to sort and filter data. 

Comments You can do all of the above in tables, but it is very easy to make mistakes, such as 
deleting or updating the wrong record. By using data entry forms, you have much 
more control over what you are doing. 

 

2.1 To move from field to field within the same record: 

 Move from the First name field to the next field by using the TAB key on the 
keyboard. 

 Continue tabbing until you reach the Gender field, then press down the SHIFT key 
(keep it held down) and use the TAB key again – this time it moves you to the 
previous field. 

2.2 To move from record to record: 

 Method 1: tab again to the Gender field and then tab once more – notice that it 
doesn’t take you to the subform or to the tabbed display but takes you directly to the 
next record. This all depends on what tab rules you set up when creating the form. 

 
Figure 3 - navigation buttons 

 Method 2: navigate between records by clicking on the various Record navigation 
buttons at the bottom of the form window. (Notice that there are buttons at the top of 
the form to do some of these actions – again, you could create buttons to do all. 
Larger buttons are generally easier to use than the Record navigation buttons at 
the bottom of the screen.) 

2.3 To enter a new record: 

 Click on the New (blank) record icon at the bottom of the screen.  

 Enter some data for your new record – just make it up (though note that you should 
only enter a number in the range of 1 to 5 in the Year field). 

 Ignore the subform – don’t enter any data there unless you’re really keen – but click 
on the Home address tab in the tabbed display instead. 

 Click on the label for Address line 1 to highlight the data entry field next to it and 
enter an address – note that you can now tab between the other fields in the Home 
address tab. 
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 Click on the Faculty details tab and choose a faculty from the dropdown. 

 Tab to the Fees paid? tick box and press down the SPACEBAR a few times to toggle 
the tick on and off. 

 
Figure 4 – the pencil icon indicates that a record is being edited and is not yet saved 

 Save the record by clicking on the column down the left-hand side of the form (if you 
tab to the next record or close the form, Access automatically saves any unsaved 
record). 

2.4 To view your new record in the underlying table: 

 In the Navigation Pane, double-click on the Student table to open it. 

 Scroll to the bottom of the record set and view your new record. 

Note    Remember that everything you do within a data entry form is reflected in the 
underlying table – so if you delete or alter anything it is gone/changed for good 
(unless you have sensibly made a backup of the database before altering data). 

 Close the Student table. 

2.5 To find a specific record to edit: 

 Click in the Last name field and click on the Find icon in the Home tab of the 
Ribbon to open the Find and Replace box. 

 Enter Jones in the Find What box, then click the Find Next button one or more 
times if necessary – we are looking for the record for Gary Jones. 

 Once you have found the correct record press the Cancel button on the Find and 
Replace box. 

2.6 To edit existing data: 

 In the record for Gary Jones, change the Gender to Female and edit the record so 
that the First name and Last name fields now say Kylie and Minogue.  

 Click in the Submission date field in the subform and enter today’s date. 

 Tab through the rest of the subform and add Music assessment in Title, Essay in 
Type and add Mark and Comments to taste. 

 
Figure 5 – Enter some data into the subform 
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 Add a couple more records into the subform underneath the first – just make it up – 
and then save the record 

2.7 To delete a record: 

 Move to the last record using the Navigation buttons at the bottom of the screen. 

 Click somewhere on the form to select the record. 

 On the drop-down arrow next to the Delete icon on the Ribbon, and choose Delete 
Record – say Yes when asked for confirmation. 

2.8 To view the Datasheet View of the form: 

Note    Datasheet View looks like a table, but includes only fields included in the form. If you 
do not have the option of Datasheet View in your own version of Access, see the 
appendices for instructions on how to set up this view. 

 
Figure 6 – you can toggle between Form View and Datasheet View of the form 

 Click on the downward arrow underneath the View icon in Home tab of the Ribbon. 

 Select Datasheet View and notice that Age is included in this view (Age does not 
appear in the Student table because it is a calculated field). 

2.9 To sort records: 

Note    You can sort in both form and datasheet views (and also in tables and queries), but 
datasheet view may be more useful because you can see many records at once. 

 Click somewhere in the Date of birth column. 

 Sort in ascending order (A to Z) followed by descending order (Z to A) using the 
icons in the Sort and Filter section of the Home tab in the Ribbon. 

 If you feel the need to sort the records back into the original order, click on the 
Remove Sort icon underneath the other sort options. 

2.10 To filter data based on a specific value: 

Note    Again, you can run filters in form and datasheet views (and in tables and queries). 

 Find Mark Smith’s record and in the Last name field double-click on Smith. 

 Click on the downward arrow next to the Selection option in the Sort and Filter 
section of the Home tab in the Ribbon. 

 Select Equals “Smith” and view the results, then click on the Toggle Filter option 
to remove the filter. 

 Click on Toggle Filter again and notice that Access remembers the last filter (this 
can occasionally be very annoying). 

 Toggle the filter off again then choose Advanced and select the Clear All Filters 
option to remove the last filter from memory. 
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Task 3 Using queries to view specific data 

Objectives To create simple single and multi-table queries and export query results to Excel. 

Comments Data are displayed according to selection criteria that you choose. Queries can be 
saved and run at any time – results will change based on the current set of data. 

 

Single table query: adding simple criteria, showing, sorting 

3.1 To create a simple single table query: 

 
Figure 7 – Query Design in the Create tab of the Ribbon 

 Close the form then click on the Create tab in the Ribbon and click Query Design. 

 In the Show Table dialogue box, double-click on Student then click Close. 

 Add FirstName, LastName, and Town from the Student table by double-clicking 
on each in turn. 

 
Figure 8 – add the above fields 

 Check the result using either the Datasheet View icon or the Run icon. 

3.2 To find all records that match a specific criteria: 

 Click on the Criteria row in the Town column. 

 
Figure 9 - setting criteria 

 Type Bristol or bristol – queries are not case sensitive (speech marks are added 
automatically when you click outside of the field.  

 Check the result using either the Datasheet View icon or the Run icon.  

 Switch back to Query Design by clicking on the Design View icon. 

3.3 To exclude a field from appearing in the query results:  

 Deselect the tick in the Show row for Town in the above query. 
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 Check the result in Datasheet View then return to Query Design. 

3.4 To sort the query by a single field: 

 Add the tick back into the Show row of the Town field. 

 
Figure 10 – select sort order from the Sort row dropdown 

 Click in the Sort row for LastName and choose Ascending or Descending from 
the dropdown box.  

 Check the result in Datasheet View then return to Query Design. 

3.5 To sort data by multiple fields: 

 Remove “Bristol” from the Criteria row in Town. 

 
Figure 11 – hover the mouse pointer over the thin, grey border above the field name 

 Hover the mouse pointer over the thin, grey border above Town – when it turns into 
thick downwards pointing arrow (as above – be warned, this is fiddly), click to 
highlight the whole Town column. 

 Click again on the thin, grey border at the top of the column and, holding the mouse 
button down, drag the field along so that it is in front of the LastName field. 

 Remove the tick from the Show row in Town. 

 Add the Town field to the grid again so that it appears twice. 

 
Figure 12 – ‘Town’ should appear twice, the first without a tick in the Show box 

 Sort the first Town (the one without the tick) and LastName, both ascending order. 

 Check the result in Datasheet View then return to Query Design. 

Note    You are using the first Town field to sort against, but you don’t want to see this field 
between the two name fields when you run the query, hence hiding the first Town 
field and then adding it again in the position in which you want to view it on running. 

3.6 To save the query: 

 Click on the Save icon above the File tab and name it TownLastNameQuery. 

 Close the query. 
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Wildcards and operators 

Note    See the appendices for explanations of these and more operators and wildcards. 

3.7 To use the * wildcard: 

 Set up a new query as before (Create tab, Query Design), adding Student from the 
Show Table dialogue box.  

 Add FirstName, LastName, Town, PaidFees, YearNumber and DateOfBirth. 

 
Figure 13 – add “l” and the wildcard symbol 

 In the criteria field for Town add l* (that’s a lowercase “L”, by the way) and run the 
query. You should get just the one record that starts with “L”. 

 Return to Design View, alter the criteria to *l then run the query again. You should 
now get lots of records that end with “L”. 

 Return to Design View, alter the criteria to *l* then run the query again. You should 
now get every record that includes an “L” anywhere within the field. 

3.8 To use the Greater Than operator: 

 Remove the criteria from above and in YearNumber enter >2, then view the query 
results. 

 Back in Design View, amend this to >=2 and view the query results. 

3.9 To use the Between operator: 

 Remove the criteria from above and in YearNumber enter between 2 and 3, then 
view the query results. 

 Back in Design View, remove the above criteria and add between e and m in the 
criteria field for LastName, then run the query again. 

And/Or criteria 

You can set criteria on more than one field. If criteria are placed on the same line, all 
criteria must be true. This is called an AND query. 

3.10 To find students who are from Bristol and have paid their fees: 

 Remove all operators or wildcards (and anything else you might have added) from 
the above query and enter bristol into the Town criteria field. 

 Enter Yes into the PaidFees criteria field and check the query results (tick boxes 
can be matched against “Yes” or “No”). 

 
Figure 14 - using more than one criteria 
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If you want to broaden your results to show records that match one of two (or more) 
different sets of criteria you can perform an OR query. 

3.11 To find those students who are either from Bristol or those who have paid their fees: 

 Remove the Yes from PaidFees. 

 
Figure 15 - using ‘and/or’ criteria 

 In the second criteria row (the OR row) in PaidFees, enter Yes. 

 Check the query results then close the query, saving it as PaidFeesQuery when 
prompted. 

Running, modifying and exporting saved queries 

3.12 To run a saved query: 

 Double-click on PaidFeesQuery in the Navigation pane and note the number of 
records returned. 

 
Figure 16 – click on the grey box 

 Delete one of the records (click on the grey box to the side of the record, hit the 
DELETE key and say Yes on the message box) then close the datasheet. 

 Run the query from the Navigation pane again and note that there is now one 
record less – yes, you can update, add and delete data in an open query! 

 Close the query again. 

3.13 To modify a query you have already saved and closed: 

 Right-click on PaidFeesQuery in the Navigation pane, and select Design View. 

 Remove all criteria and enterYes in the criteria row for PaidFees again. 

 Close the query again and save it when prompted 

3.14 To export a query to Excel: 

 Right-click on PaidFeesQuery, then select Export, followed by Excel. 

 If in the training room click on Browse and save the file to your own MyFiles space: 
if elsewhere it is easiest to save to the Desktop – click Close on the splash-screen 
that opens asking if you want to save the export steps. 

 Navigate to where you saved the file and double-click on it to open it in Excel. 
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Task 4 Multi-table queries 

Objectives To create queries using more than one table. To use different table joins and see 
the difference in data returned by the query based on join. 

Comments One of these queries will be used later as the basis of a grouped report 

 

4.1 To create a multi-table query to be used later as the basis for a report: 

 Create a new query and add the Faculty, Student and Subject tables. 

 
Figure 17 – create a three table query 

 From Faculty add: FacultyName; RegDate; Contact; Fees: from Student add: 
FirstName; LastName; YearNumber; PaidFees: from Subject add: CourseName. 

 Run the query, check the results then return to Design View and close the query, 
saving when prompted as QueryForReport. 

Multi-table query with different table joins 

4.2 To create a multi-table query and see the results based on different table joins: 

 Create a new query and add the Student and Subject tables. 

 From Student add FirstName and LastName and from Subject add CourseName. 

 Run the query, check the results and return to Design View. 

 
Figure 18 – right-click on the relationship line (this can be fiddly) 

 Right-click on the relationship between the two tables and select Join Properties. 

 Select the second option, click OK then run the query to see the different results – 
you can now see all courses irrespective of whether any students are attached. 

 Now try the third option – what is this doing? – and close the query without saving it. 
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Task 5 Create an update query (if we have time) 

Objectives To create a query to change data in the underlying table. 

Comments You cannot update a Number field with text – in the following task the Sex field, 
although containing numbers, is a Text field. If you try to update a field that is too 
small to accept the update text, the update text will be truncated. 

 

Warning!     Action queries can seriously damage the data in your database. Always make a 
backup of your database before creating new (or running saved) action queries. 
Never double-click on an action query in the Navigation Pane just ‘to see what it 
does’ because it will do it. Always check in Design View first by right-clicking on it in 
the Navigation Pane. 

5.1 To change the entry in the Gender field from 2 to Female: 

 Create a new query and add the Student table. 

 Select Update from the Query Type section of the Ribbon.  

 Add the Gender field to the QBE grid and type 2 in the Criteria box and enter 
Female in the Update to box. 

 
Figure 19 – the QBE grid should look like this 

 View the values that be will changed by selecting Datasheet View (do not select the 
Run icon yet) – you should see a column of approximately fifty rows with 2 in 
each. 

 Return to Design View and select Run, followed by Yes to confirm.  

 To see what you have done double-click on Student in the Tables section of 
the Navigation Pane.  

 Close the Student table and close the query, saving it as UpdateToFemale.  

5.2 To practice creating an update query: 

 Create a new query and change 1 to Male. 

 Check the Students table then close both table and query, saving changes to the 
query as you close it. 
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Task 6 Create a grouped report based on a query 

Objectives To create a grouped report using one of the multi-table queries we built earlier. To 
filter report data. 

Comments For information on fine-tuning and modifying reports, see the training document 
“Access 2013 - Building Access databases - further tasks”, which is available from 
www.bristol.ac.uk/it-services/learning/resources (type “acc-47” into the Keyword box 
and download both the document and the practice file). 

 

6.1 To create a report using the Report Wizard: 

 
Figure 20 – select Report Wizard 

 Click on the Create tab on the Ribbon and select Report Wizard. 

 In Tables/Queries select Query: QueryForReport.  

 
Figure 21 – select all fields 

 Click >> to add all the fields to Selected Fields and click Next. 

 When asked how you want to group the data, select by Faculty (this should already 
be highlighted) and click Next, followed by Next again. 

 
Figure 22 – sort by CourseName followed by LastName 

 Select CourseName from the first dropdown followed by LastName from the 
second dropdown box, then click on Next. 
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 Choose Outline for the look of the report and click Next. 

 Name the report RegistrationReport and click Finish to preview the report. 

 
Figure 23 – basic grouped report created using Report Wizard 

 Click on Close Print Preview and notice that you are taken directly to Design View, 
where, if you want, you can experiment with altering the position and size of labels, 
fields and so on…except that this is not covered on this particular course, so only 
have a dabble if we have time. 

6.2 To filter data on a report: 

 Close the report, then double-click on it in the Navigation pane to open it again – 
notice that the report opens in what is called Report View rather than in Print 
Preview. 

 In the grouped section for Arts, double-click on the last name for Suzy Jones, so 
that just “Jones” is highlighted. 

 In the Sort & Filter section of the Ribbon click on the downward arrow next to 
Selection and choose Equals “Jones”. 

 View the results and then click on Toggle Filter to view all records again. 
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Appendix A Datasheet view and operators/wildcards 
Comments Depending on version of Access you may not see datasheet view of a form – some 

versions of Access have dropped this as a default despite the fact that it’s really 
useful. 

 

Datasheet view 

6.3 To add Datasheet View: 

 Open the form in Design View view. 

 
Figure 24 – notice that a small, black box appears when you click on it 

 In Design View, click on the small box in the top, left-hand corner of the 
form so that a small, black rectangle appears. 

 Open the Property Sheet and select the Format tab. 

 Change Allow Datasheet View to Yes (and change Allow Layout View to No if 
you want to – Layout View is not very useful in a UoB context of use). 

 View the form in Datasheet View, then return to Design View. Notice that you now 
toggle directly between Form View and Design View – that’s much better! 

Operators and wildcards 

Criteria operators 

Operator Meaning Example 

< 

 

<= 

Less than 

 

Less than or equal to 

<2000 would find all values up to and 
including 1999 

<=2000 would find all values up to and 
including 2000 

> 

 

>= 

Greater than 

 

Greater than or equal 
to 

>2000 would find all values from 2001 
upwards 

>=2000 would find all values from 2000 
upwards 

<> Not equal to <>0 would find all positive and negative 
(non-zero) numbers 

Between X 
and Y 

Any of the given 
values 

Between 1500 and 2000 would find all 
values from 1500 to 2000 including both 
1500 and 2000 

 

 For a list of all available operators, see http://office.microsoft.com/en-
gb/access-help/table-of-operators-HA010235862.aspx 

 

http://office.microsoft.com/en-gb/access-help/table-of-operators-HA010235862.aspx
http://office.microsoft.com/en-gb/access-help/table-of-operators-HA010235862.aspx
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Wildcards 

Character Meaning Example 

? Matches one 
character 

B?t would find Bat, But, Bet, but not Boat, 
etc. 

* Matches any 
number of 
characters 

B*t would find Bat, Boat, Bracket, etc. 

# Matches a single 
digit in a text field 
(this does not work 
on a numeric field) 

3#5 would find 375, 385, etc. 

#05 would find 105, 205, etc. 

 

 For a list of all available wildcards, see: http://office.microsoft.com/en-
gb/access-help/access-wildcard-character-reference-HP005188185.aspx 

http://office.microsoft.com/en-gb/access-help/access-wildcard-character-reference-HP005188185.aspx
http://office.microsoft.com/en-gb/access-help/access-wildcard-character-reference-HP005188185.aspx

